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Foreword                                                           _________ 

Congratulations! 

 

You have just purchased a world leading product! 
 

To ensure that you achieve the full potential of this software please follow the Operators Manual instructions carefully.  

As we are continuing to improve this product please email winpats@wavecom.com.au to receive any available updates and/or 

any other information relating to this product.  

We welcome any comments so that we can continue to provide you with the best product of this kind on the market.  

 

 



Introduction 

Apart from the responsibility of maintaining electrical appliances and equipment, on a regular basis most businesses are faced 
with the massive clerical workload of maintaining a reliable and accurate asset & electrical testing recording system. Once 
regular checks of all portable appliances have been completed, a comprehensive record system must be kept! This is where 
WinPATS™ software makes the task easy!  

WinPATS™ is a Windows-based portable appliance testing software package designed for desktop PCs and laptops. These 
software packages are to be used in conjunction with a PAT tester, which physically tests the appliance, while WinPATS™ 
records the data safely and effortlessly!  It is our recommendation that the portable appliance tester model/s; TnT, TnT-el or 
TnT+ are used in conjunction with WinPATS™ Lite as this software has been designed specifically for use with these PAT 
testers.  Please go to www.wavecom.com.au for details of your nearest retailer or contact WinPATS™ Technical Support.  

Features 

WinPATS™ Lite 

• Asset Register  
• Equipment performance monitoring  
• Automated test data uploading  
• Workload forecasting and test scheduling  
• Enhanced report and barcode capability  
• Equipment history profile  
• Powerful search facility  
• Pass/Fail settings  
• Merging database test results from multiple downloads and devices  
• Compliance Certificate printouts  
• High security features allowing user controls and controlled access  
• Overdue testing and maintenance  
• Overseeing OH & S general testing requirements  
• Mechanical equipment testing capability  

Expectations 

It is expected by the manufacturer that the operator of this software is not only recognised as the “Competent Person” as 
described below, but also has a minimum of medium to advanced computer skills.  

The Technical Support Team takes no responsibility for operators who do not have the required skills to operate a computer. If 
the operator does not have the skills & ability to operate a basic computer, this may affect the validity of the 30 Day Free 
Technical Support as well as any additional support packages purchased. This assessment will be at the manufacturers’ 
discretion. Please contact WinPATS™ Technical Support for more information regarding assessment and the appropriate levels 
of computer skills 

Notes on Functionality 

For WinPATS™ LiteBase users, some functionality has been disabled. These functions are available in WinPATS™ Lite. For 
more information regarding this please contact WinPATS™ Technical Support.  

WinPATS™ Technical Support: 
WinPATS™ Lite 
WinPATS™ MX 
WinPATS™ Base 

National (08) 8243 3500 
International: (+61) 8 8243 3500 

Email: winpats@wavecom.com.au 
Web: www.wavecom.com.au 



Safety Warning 

 

PLEASE NOTE:  

The following information; Safety Warning, Competent Person and Disclaimer, refers specifically to the 
use of the Portable Appliance Testers (TnT, TnT-el & TnT+), that may be used in conjunction with this 

software, and does not refer to the software itself.  

This software in itself in no way poses a risk to the operator’s safety.  

  

When using any electrical appliance SAFETY must always be observed.  Testing appliances is no exception and in fact MORE 
care must be taken to ensure personal safety is met. 

Although the TnT range of appliance testing products has been designed to meet stringent requirements, no person can be 
completely protected against the consequences of the incorrect use of an electrical device. 

We advise that appliance testing should be conducted by a competent and suitably trained person. 

For maximum safety, always ensure that the following advice is followed: 

• The equipment being tested is in good working order  
• All user instructions are followed  
• Double check power supply connections (LEDs) to the TnT appliance tester  
• Always use specified fuses and protection devices  
• Do not use leads that require repair or are damaged  
• If you are unsure, call a Licensed Engineer/Electrician  

Competent Person 

Regulations require that a ‘Competent Person’ such as a Licensed Electrician be employed to perform all or any of the 
electrical tests that are mentioned in this operator’s manual. This is to ensure that all devices under test are inspected, tested 
and tagged safely and correctly.  

A person competent to undertake Inspection and Testing of electrical equipment must have 

1. Knowledge and practical experience of electricity and its hazards  
2. A clear understanding of precautions to avoid danger  
3. The ability to recognise, at all times, whether it is safe for work to continue  
4. The ability to carry out visual examinations of electrical equipment  
5. The ability to distinguish between electrical equipment that is double insulated and equipment that is earthed as well as 

being able to identify the appropriate test for each type  
6. The competency to safely carry out the Earthing Continuity, Insulation Resistance or Leakage and RCD tests on 

electrical equipment safely  
7. The knowledge of how to use the relevant testing instruments, interpret and record results for compliance with the 

Standard/Workplace requirements  
8. The knowledge to be able to correctly recommend the frequency of testing required  

DUE TO THE POTENTIAL HAZARDS OF ELECTRICAL TESTING, ALL CARE MUST BE TAKEN 

 



Disclaimer & Limited Warranty 

LIMITED Warranty 

The Manufacturer warrants its products against defects in materials and workmanship for a period of 12 months from the date of 
purchase.  During the warranty period, the manufacturer will repair (or at its option replace at no charge) the product that proves 
to be defective.  This warranty does not apply if the product has been damaged by accident, abuse, misuse or miss-application 
or as a result of service or modification by anyone other than Electromate TnT. 

Electromate TnT product range of devices or its’ manufacturer IS NOT RESPONSIBLE FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES RESULTING FROM THE BREACH OF ANY EXPRESS OR IMPLIED WARRANTY, 
INCLUDING DAMAGE TO PROPERTY AND TO THE EXTENT PERMITTED BY LAW, DAMAGES FOR PERSONAL INJURY. 
The Distributors of this product cannot assume liability or responsibility for any loss or damage resulting from the use of this 
device. 

Electromate TnT manufacturer reserves the right to discontinue models, change specification, price or design, at any time 
without notice or obligation. 

System Requirements 

PC Based Operation 

Asset Testing Software: 

• WinPATS™ Lite  
• WinPATS™Base  
• WinPATS™ MX  

Equipment: 

• Portable Appliance Tester (PAT Tester) models TnT, TnT-el or TnT+  

Other Items: 

• Serial Cable  
• Dongle (RJ to Serial)  
• USB to Serial Cable (Adaptor)  
• USB Cable  

System Requirements (Minimum Recommended) 

• Pentium 2, 600Mhz or higher  
• 75MB of available hard disk space  
• 64MB RAM  
• Microsoft Windows 2000/XP/Vista/Windows 7  
• Optical Drive  
• Available Serial Port, or  
• Available USB Port - with an installed USB to Serial Driver  

Notes: If using a TnT (and/or TnT-el or TnT+) portable appliance tester and running Windows, you may be required to install a 
USB TO SERIAL DRIVER. Please refer to the CD Installation Guide accompanying the USB to Serial Cable for instructions on 
installing the Driver, or seek advice from your Administrator.  

 

 

 



Registering WinPATS™ 

To ensure that you receive the full benefit of owning and operating WinPATS™ software, the product must be registered with 
the manufacturer, Wavecom Instruments Pty Ltd. 

When you register WinPATS™ you will receive 30 days of Introductory Support to use within 6 months, which will begin from 
your first contact with a Technical Support Representative. Once we know who you are you will also receive information about 
upgrades and new products as well as exceptional service & support.  

1. To register WinPATS™ software, you are required to provide the following information:  
a. Serial number of the software (4 digit number on the installation CD)  
b. Contact name  
c. Company/Organisation name  
d. Address, phone & fax numbers  
e. Email address  
f. Date of purchase  
g. Software platform (i.e. 2000/NT/XP/Vista/Windows 7 etc)  
h. Type of Business  
i. Number of employees  
j. How you learnt about WinPATS™ software  
k. Where software was purchased 

   
2. How to register:  

a. To register via Internet 
Go to www.wavecom.com.au 
   

b. To register by Email 
Provide the information stated in section 1. and email to winpats@wavecom.com.au 
   

c. To register by fax 
Complete registration form accompanying product and fax to 
National: (08) 8243 3501 
International (+61) 8 8243 3501 
   

d. To register by phone 
Call Wavecom Instruments between 9am - 5pm CST Mon-Fri 
National: (08) 8243 3500 
International: (+61) 8 8243 3500 
   

e. To register by mail 
Complete the registration form accompanying product, place in an envelope and mail to 
Wavecom Instruments 
257A Grange Road 
Findon, South Australia, 5023  

Notes: A hard copy of the registration form is included in the software packaging and a soft copy is included on the WinPATS™ 
installation CD 

 

 

 

 

 



TnT Portable Appliance Tester Diagram 

 

WinPATS™ Code & Colour Guide  

To access Code & Colour Guide, go to Help > Code & Colour Guide 
   

Click images to enlarge 

Screen 1 

 

Screen 2 

 

  

Main Screen 
(P) Pass Black 
(F) Fail Red 
Test Overdue Blue 
(OOS, O) Out of Service Kakhi 
(NTS) New to 
Service/Untested Green 

(R) Recalibration Required Grey 
  



Test Details   
(P) Pass Green 
(F) Fail Red 
(S) Skip Grey 
(A) Auto - Determines P or F Automatically 

 

Quick Start Guide Refer To: 
Step1 
Install Software WinPATS™ on PC/Laptop Installation 

Step 2 
Register WinPATS™ with Wavecom Instruments Registering WinPATS™ 

Step 3 
Connect TnT appliance tester to PC/Laptop Getting Connected 

Step 4 
Open WinPATS™ Program & New Database Creating a Database 

Step 5 
Customise 

Software to your requirements  

a. Setup Site/s  
b. Setup Locations  
c. Add New Equipment  
d. Assign Test Categories to Equipment 

   

WinPATS Lite Users: 
Adding Equipment  

WinPATS MX users: 
Testing 

Step 6 
Perform Visual Test, Other Tests 

WinPATS Lite Users: 
Testing  

WinPATS MX Users: 
Testing and Management 

NOTES: 

1.   For more detailed instructions for each step please refer to specific related chapter & page.   

2.   For WinPATS Base users – ‘To Create a New File’ is not a valid option. Go to [File>Open Database] and not [File>New 
Database]. See Troubleshooting  

3.   It is expected that the operator will familiarise themselves with the software categories & functions. 

4.   Because of the nature of these tests it is a requirement of operation that the operator considers themselves as the 
‘Competent Person’ as outlined in Important Information. As such it is expected that you will be familiar with which test/s are 
required as standard for which electrical appliance/s. If you are not aware of these standards, we advise that you consult an 
electrician before proceeding any further. 

  

 

 

 

 

 



Installation 
1. Insert WinPATS™ Installation CD in to CD drive of computer. The auto start function should load the menu 

automatically. From the main CD menu click on the "Install WinPATS" icon. If the auto menu does not appear, read step 
2.  

2. Go to [My Computer] and open the WinPATS™ Installation CD (by double clicking on the drive).  
3. Open the AutoRun.exe file.  
4. From the main CD menu click on the "Install WinPATS" icon.  

  

Click image to enlarge 

Screen 

1  

Screen 

2  

Screen 

3  

Screen 

4  

Screen 5 

 

5. To install WinPATS™ in to the default folder C:\WinPATS Mx 3.x.x\ 
click [Next >] on Screen 5.  To change the folder to which WinPATS™ is installed, click [Change...] on Screen 5 to 
browse and choose a different directory (Please note: it is advised that this option is used by advanced users only. We 
recommend the program be installed in the default folder.)  

Screen 6 

 

6. To install WinPATS™ click [Install] on Screen 6.  To change current settings, click [< Back] and go back to Screen 5 
(Please note: it is advised that this option is used by advanced users only as the following instructions are based on no 
settings being changed.)   

The program will now install.  This may take several minutes. 

Screen 7 

 

Screen 8 

 

Screen 9 

 

7. During the installation process please read the End -User Licence Agreement (for a required additional software 
program called 'Microsoft Data Access Components 2.0 Installation Program',Screen 8)  

If you accept the terms of the End-User Licence Agreement, click [Yes] 
If you do not accept the terms of the End-User Licence Agreement, click [No] 

Please Note: If you choose ‘No’, the install program will close. To install this software you must accept this agreement. The 
instructions following are based on the End-User Licence Agreement being accepted. 

8. Additional software ‘Microsoft Data Access Components 2.0 Installation Program’ is required for this WinPATS™ 
installation. This software will install automatically as part of the WinPATS™ installation process.  Please read the 
following information regarding setup, copyright and the End User License Agreement.  



Screen 10 

 

If you agree with these terms, click [Continue] on Screen 10, by choosing to continue you indicate acceptance of these terms.  If 
you do not agree with these terms, click [Exit Setup].  This will end the installation of the software.  The instructions following are 
based on these terms being accepted.   

Screen 11 

 

9. Select your preferred installation.  To install all data components, click [Complete] on Screen 11.  To install data 
components manually, click [Custom] (Please note: It is advised that this option is used by advanced users only as the 
following instructions are based on a Complete installation.  

Screen 12 

 
Screen 13 

 

Screen 14 

 

Screen 

15  

Screen 16 

 

10. Microsoft Data Access Components 2.0 Setup was completed successfully. click [Ok] on Screen 13  
11. To complete installation, click [Finish] on Screen 15  
12. To run WinPATS™ go to Start > Programs > WinPATS™ (Screen 16)  
13. First time installers will be required to enter the user details and a product key into the register WinPATS screen (screen 

17). This is not required under re-install.  
14. Enter your company name, phone number and product key. Only numerical characters can be used in the phone no 

and product key fields. The 16 digit product key number is found on the back of the CD case or CD envelope.  
15. If you receive a invalid product key message, double check the number was entered in correctly. If the product key is 

still invalid, contact Wavecom Instruments for help.  
16. If you receive a reg error message, shut the program down and reopen from the newly created icon on the desktop. If 

WinPATS loads correctly and does not display the register WinPATS screen then the installation was a success. If you 
are still stuck on the register WinPATS screen then contact Wavecom Instruments.  

Screen 17 

 

 
 
 
 



Getting Connected 
There are 3 ways to connect the TnT to a computer; VIA a serial cable, USB cable & USB to serial converter.  

If you are using a desktop computer or an old laptop computer you can use the inbuilt com ports provided. These built in com 
port are usually assigned to com 1 or com 2. You will need to experiment with these com port numbers in the WinPATS options 
to find the correct com port. See screen 12.  

 

Serial cable  

   

If no built in serial ports are available then you will need to use the USB cable or USB to serial device provided. If the straight 
USB cable or USB to serial device is used, drivers will need to be installed to ensure correct functionality. If the drivers are not 
installed correctly you will not see the USB device listed as in the screen 10 & 11 example. Please make sure that the USB to 
serial device is not plugged into the computer when installing the driver. The device can be plugged in after the 
installation is complete. This will avoid a computer restart.  

Insert the WinPATS CD and wait for the auto start menu to appear. Please click the links from the CD main menu to install the 
relevant drivers:  

   CD Menu Name:                                   Device:  

XP serial to USB driver 

Vista & Win 7 serial to USB driver 

 

USB to serial device 

USB to USB Driver (XP & Vista & Win 
7). This communications method is used 
in all modern TnT appliance tester. 

 

USB cable 

Follow the installations steps and complete the setup program. Connect the appliance tester to the PC and make sure the 
appliance tester is powered on.  

Note: If you are using a USB to serial device you will still need to use the serial cable provided. Because of the connection ends 
the USB to serial device will not plug directly into TnT appliance tester.  



If the driver was installed correctly you should be able to see your USB com port listed like in screen 10 or 11 depending on 
which type of connection you have. The com port number is determined by the next available com port on the computer. It is 
important to make sure the USB to serial device is plugged into the same USB port every time. The com port number can vary 
depending on which USB port it is plugged into.  

Once the drivers are installed, ensure that the port number in WinPATS options is the same as the port number in device 
manager. Use the com port number located in device manager (screen 10 & 11) and enter the same value into WinPATS 
options (screen 12).  

The TnT tester must be switched on and plugged into the computer for the com port to be visible in device manager.  

To find device manager follow the arrows in screens 1 to 5 or screens 6 to 9 depending on the computer operating system.  

   

Windows XP: 
   

Screen 1 

 

Screen 2 

 

Screen 3 

 

Note: If you have classic view selected your control panel will appear as in screen number:  

Screen 4 

 

Now select device manager from system properties  

Screen 5 

 

   

 

 

 

 

 



Windows Vista: 
   

Screen 6 

 

Screen 7 

 

Screen 8 

 

   

Screen 9 

 

If UAC (user account control) switched on you will be prompted with this screen. Click the continue button. Administrative rights 
are needed to get past this point. Please consult your IT admin for further help.  

Device Manager: 
   

Screen 10 

 

Screen 11 

 

Click on the small plus symbol to expand the ports section. The com port number is displayed in the brackets of the device. Both 
USB to serial and USB to USB examples are provided in screens 10 and 11.  

   

WinPATS: 
   

Screen 12 

 

From the WinPATS program choose the file menu and then select options. Enter the com port number into the TnT com ports 
box. Please remove any numbers so there is only the new number in the box. Select Ok, the com port is now assigned to the 
number entered.  



To find out if the communications settings are correct read the introduction section in downloading records and then perform the 
date / time check on the TnT.  

   

TnT Communications Troubleshoot  

Only try the following tip if you are sure that the correct com port have been entered into the WinPATS options. 
  

• The com port number must be under 10 for WinPATS to accept the com port number. To change the number load 
device manager, right click on the USB to serial device then click properties. Select port settings then advanced. 
Choose a different number from the drop down box.  

• Make sure that the com port listing is in the ports section in device manager. If it's in other devices there was a error 
while installing the drivers.  

• Switch the tester on and make sure it is plugged in before going to the "TnT communications" in the downloads menu.  
• Always use the drivers provided on this CD. Other driver versions can be problematic and don't work with the 

equipment.  
• Check to see if there are programs interfering with the com port (eg. mobile phone, data logging software). There are 

programs like "Free serial port monitor" to analyse the com port.  
• Is there a Windows printer installed on that PC? The printer port may be set to the same com port as the USB to serial 

device. If this was the case then it would not allow communications with the TnT tester.  
• The com port could be restricted by some software (admin control or Firewall)?  
• Try communicating with hyper terminal, com settings (9600 baud, 8 data bits, parity none, stop bits 1, handshaking 

none). Type GSN in capitals (press enter) to see if the TnT responds.  
• Try WinPATS on another PC. This will determine if the problem is PC related.  
• If the problem cannot be determined contact Wavecom Instruments for help.  

  

  
 
 

 

 

 

 

 

 

 

 



WinPATS Configuration 

Setting Up The Options 

Some options will need to be configured prior to using WinPATS™ .   

To access options menu, click File > Options (Screen 1) 

Screen 1 

 

  

General Options Tab (Screen 1)  

  

Screen 1 

 

1. Allow Intermediate Tests 
An intermediate test is the same as a normal test but it does not effect when the equipment is due for its next test. For 
example, if a fridge is due for testing in three weeks and an intermediate test is performed, a test will still be due in three 
weeks.  

2. Logging Interval For Power Test 
By using the TNT_LOG_POW_TST test category, a TnT+ can perform a power test for an indefinite period and the 
readings can be recorded in a log file at the interval specified.  If the test is long, the interval should be greater and the 
log file could become large.  The log file can be analyzed and graphed in programs such as excel. Function only 
available when testing with WinPATS not available in memory stand alone units.  

3. TnT Com Port/s 
The Com Port that the TnT uses should be input here.  Check which Com Port the appliance tester will be using and 
input the correct Com Port number in the specified box.  If you do not know which Com Port is being used, click Start > 
Control Panel > System > Hardware > Device Manager (See pictures below). For more details on setting up com ports 
click here.  

 

 

 

 

4. Default Test Status 
Here you can choose which code to use as the default test status (before the item is tested).  Leave blank if in doubt  



5. Link Description to Test Categories 
Tick this box if you prefer the description of an item to be linked to the test categories. If you do this only test categories 
will be shown in the description field when setting up new equipment.  

6. Graphics for Reports 
This option allows the user to select an image, e.g. company logo, to be used in the reports.  Default is no image.  

7. Control Panel 
The button opens the Control Panel for easy access.  

8. Restore Grid Defaults 
This restores all grid columns to the default setting. This can be used if you loose one of the columns in the equipment 
inventory.  

RCD Test Tab (Screen 1) 

Screen 1 

 

Note: These options apply to the TnT+ when performing RCD tests 

1. Perform Button Test 
Enable this test if a Button Test is applicable, otherwise disable it. Enabling the test button will prompt the user to do a 
RCD button test before the main RCD test. The result is recorded as a visual style test.  

2. Current 
The default setting for this option is 10mA.  Only change this setting if you are a competent user.  Alternatively, consult 
an electrician before proceeding with option.  

3. Multiplier 
The default setting for this option is 1.  Only change this setting if you are a competent user.  Alternatively, consult an 
electrician before proceeding with this option.  

4. Phase 
The default setting for this option is 0 Deg.  Only change this setting if your are a competent user.  Alternatively, consult 
an electrician before proceeding with this option.  

5. Type 
The default setting for this option is || (300mS).  Only change this setting if you are a competent user.  Alternatively, 
consult an electrician before proceeding with this option.  

 

 

 

 

 

 

 



Barcodes Tab (Screen 1) 

Screen 1 

 

1. Digits 
The default setting for this option is 6.  This setting determines the standard barcode length for all equipment in the 
database.  Enter this figure accurately.  Note that zeros are significant in WinPATS™ Lite, e.g. barcode 000111 is 
different from barcode 111.  

2. Auto Adjust 
Tick this box to turn on auto adjust barcodes.  This option must be used with care.  Auto Adjust uses the digits setting to 
either shorten an entered barcode if too long or , or lengthen a barcode if it is too short.  For example. if the Digits 
setting is 6 and '1234' is entered, it will be adjusted to '001234'.  On the other hand, if '1234567' is entered, it will be 
shortened to '234567'. The change is always made on the left side. When would be it advisable to turn Auto Adjust on?  
If a barcode reader is not present and barcodes need to be entered by hand, Auto Adjust may save time by avoiding 
entering zeros.  If any new equipment already has a barcode/s of various lengths, and it is preferred that all barcode 
lengths are standard it is recommended that new labels are printed off immediately after standardising the barcode, 
otherwise Auto Adjust will have to be on every time you scan that equipment. Using Auto Adjust may present problems 
if your database contains equipment that have a variety of barcode lengths.  It is recommended that all equipment have 
a standard barcode length.  

3. Auto Generate for New Equip 
Tick this box to turn on auto generate barcodes for new equipment. This option will automatically generate a barcode for 
new equipment.  If you add multiple equipment at a time Auto Generate is activated automatically. These barcodes are 
sequentially generated.  

4. Scan By 
Choose which method you would prefer.  

5. Leakage Test Duration 
Choose your preferred test duration and click  Assign Duration.  

6. Earth Bond Current (Only available on TnT 3PL) 
Choose your preferred earth bond current setting and click Assign Current  

Label Printing Tab (Screen 1) 

  

Screen 1 

 

1.  
2. Label Format Files 

If the use column is not ticked (default setting) then no label file is required. A set of default label information will be sent 
to the printer (the majority of WinPATS customers can use this option). If you have custom label files you will need to 
tick the use box and provide a path to the *.wbl files.  It is possible to have several different tags, contact Wavecom 
about designing a custom label or printing on your existing labels. Ignore the file 2 rows, these are used for special tag 
printing functions.  



3. Print New To Service Tags 
Tick this box to print new to service tags - applies to PDA devices only.  

4. Store on SD Card 
This option is only available with an SD Card and WinPATS™ CE installed on it - applies to PDA devices only.  

Printers Tab (Screen 1) 

  

Screen 1 

 

Current default printer on PC 
WinPATS sends the printing information to default printer. The default printer must be set to the Zebra TLP2844-Z or Zebra 
TLP2824-Z in order to enable printing of tags.  To select printer, click View Printers and select the Zebra TLP2844-Z or Zebra 
TLP2824-Z.  If you cannot locate the printer, refer to the troubleshooting section.  If the wrong printer is selected, the text will be 
highlighted in red. 

For help installing the Zebra printer drivers click here. 

Lock-in reports printer 
If you have Zebra TLP printer you must lock-in a A4 printer to print your reports correctly. Click here to read about why it is 
important to have printers configured correctly for reports. To lock-in your reports printer: 

1. Set you A4 printer as your default printer.  
2. Click the lock-in reports printer button.  
3. Set your Zebra TLP as the default printer.  
4. Once finished your screen should look like (screen 1).  

  

 

 

 

 

 

 



Creating a Database 

New Database 

This function is only available in WinPATS™ MX and WinPATS™ Lite, not WinPATS™ Base, for more information see 
Troubleshooting and/or see note below. 

Screen1 

 

Screen 2 

 

Screen 3 

 

Screen 4 

 

Screen 5 

 

  

1. Click WinPATS™ Program Icon to open (Screen 1) 
2. Click [File] > [New Database] (Screen 2) 
3. Select a location for your new file in Look in:  (Screen 3) or leave as default. It is good practice to store your databases 

in a designated folder. Operating system such as Windows Vista may require you to save your databases in the 
document folder.  Any other folder may be blocked from saving. 

4. Enter a name for the new database in File name:  Click [Open] 
5. Choose from the drop down box the user that is going to log in. There is only the admin user at the moment to just click 

Ok. To learn more about users click here. 
6. Select if you would like to use passwords for this database. If you choose yes you will be asked to enter a new 

password on next login. For more details on passwords click here. 

NOTES: 

1. Each time you create a new database you will be required to login using the default User ID and password, then you will be 
asked to change the password [Step 6] 

2. The passwords are not case sensitive 

3. Once the password has been changed from the default setting, the manufacturer or any reseller of this product is unable to 
unlock the new password.  

4. *For WinPATS Base users – ‘To Create a New File’ is not a valid option. Go to [File>Open Database] and not [File>New 
Database] See Troubleshooting 

Open Database 

  

Screen 1 

 

Screen 2 

 

1. Double Click [WinPATS™ Program Icon]  
2. Click [File]  
3. Click [Open Database]  
4. Click once on required file (Screen 1)  



5. Click Open   
6. Login by selecting your User ID from the drop down box and then enter password. Click [Ok] (Screen 2).  
7. The selected file will open ready for data input and collection  

NOTES; 

Important Information 

• WinPATS™ will remember the four most recently used databases.  You can open them quickly by selecting them at the 
bottom on the file menu  

• Each time you create a new database, you will be required to login using default User ID and Password, you will then be 
prompted to change it  

Importing 

If you have the following: 

• Old WinPATS database 
• A spreadsheet containing previously tested equipment 

Then you may need to import the data into the WinPATS database. Use the procedures list below to import the data. If you have 
nothing to import then click here to skip these steps. 

  

Import Database 

If you have an existing WinPATS™ database and you wish to import it: 

• Click on [File>Merge/Import Database]  
• Select the existing database.  
• Click [Open]  

You can use this method to combine several old databases into one.  If you experience problems during or after importing an 
old database contact Technical Support for advice.  

If you import a database you may need to convert old Test Categories, if you are using a TnT(+) and are importing from 
WinPATS™ V1.87.  

If you do NOT import a database you must ‘Add A Site’ 

Import CSV 

Import facility is provided to allow for easy upload of equipment data into the database. Import is recommended for initial 
population of empty database however data can be imported into a database with data. It is user’s responsibility not to import 
identical data into database more then once. There no validation on duplicity, as it is perfectly legal to have multiple identical 
items. 

It is highly recommended that you modify the example CSV on the WinPATS installation CD to import data. The first line 
of the file contains all the field names that are formatted correctly. The file is located under the \Extras\CSV Import folder.  

Import file must be in CSV (Comma Separated Values) format. MS Excel and other programs can generate CSV file by saving 
data as .csv 

 

 

 



Example of data for import shown in a spreadsheet 

Site Location Barcode Description Make Next Test 
Date Frequency Test Category 

Flinders 
Hospital Theatre 1 00230 Portable 

Heater GEC 01/12/2006 Yearly Small Appliance 

Flinders 
Hospital Theatre 2 00288 Anesthetic 

Mach ULCO 01/12/2005 Monthly Anesthetic 
Mach 

The same data when saved as CSV file. CSV files can be viewed when opened in notebook. It is recommended that a CSV 
editing software is used to modify the CSV file. 

  

Site, Location, Barcode, Description, Make, Next Test Date, Frequency, Test Category 

Flinders Hospital, Theatre 1, 00230, Portable Heater, GEC, 01/Dec/2005,Yearly,Small Appliance 

Flinders Hospital, Theatre 2, 00288, Anaesthetic Mach, ULCO, 01/Dec/2005, Monthly, Anaesthetic Mach 

  

Note 1: Items might be surrounded by quotes, e.g. “Flinders Hospital” 

Note 2: Dates might be shown with “#”, e.g.  #1/3/2004# 

Note 3: Sometimes the Barcode is shown as 230, as spreadsheet program assumes 230 is a number and leading zeros are not 
shown. The import facility treats Barcode as a special case and restores leading zeros to be as specified in WinPATS™ menu 
item File > Options > Barcode. 

The first line determines and describes what type of data is being imported. Order of columns is not important. 
The case of text fields is not important for database storage, i.e. “Flinders” is the same as “FLINDERS”. Case supplied is what is 
stored and shown on screen and reports. 

Importing Sites and Locations Only 

It is possible to populate database with site name and all site details. There are only 2 columns required, the rest of the data is 
optional. Compulsory items are Site and Location and the rest of the fields can be blank for individual records or not mentioned 
at all. 

Tables show properties of imported fields. All fields are alphanumeric text. Column headings must be spelt exactly, the case is 
not important.  

Compulsory Fields 

Column Name No of Characters Note 
Site 40   

Location 40 If locations are unknown, the 
location "None" can be used 

 

 

 

 



Optional Text Fields 

Column Name No of Characters Note 
Street 50   
Suburb 30   
State 3   
Postcode 5   
Contact Name 50   
Contact Ph 1 15   
Contact Ph 2 15   
Contact Fax 15   
Site Notes 50   
Site Email 40   

Site details are imported into database only when the site is being imported as new to WinPATS database. In other words, it is 
not possible to change Site details for an existing Site by using import function. 

Importing Equipment Details 

Import function allows user to populate WinPATS database with bulk of Equipment data. This a viable and efficient option when 
an user can obtain assets (equipment) information from another program and package as CSV file. 

There are only some columns required, the rest of the data is optional. Compulsory items are Site, Location and Barcode and 2 
out of 3 date related items. Rest of the fields can be blank for individual records or not specified at all. 

Tables show properties of imported fields. All fields are alphanumeric text. Column headings must be spelt exactly, the case is 
not important.  

The case of text fields is not important for database storage, i.e. “Flinders” is the same as “FLINDERS”. Case supplied is what is 
stored and shown on screen and reports. 

Compulsory Fields 

Column Name No of Characters Note 
Site 40   
Location 40   

Barcode 20 
At least 1 character, padded with leading 
zeros if needed, does not have to be unique 
however it is recommended within a site 

Site and Location might already exist, or if new are created. 

Compulsory Date Related Fields 

To be able to report on equipment you need to populate test date/s and frequency of testing. Dates can be shown in any format 
that can be evaluated as a valid date. It is recommended to use a longer format with month spelt out to avoid confusion as dates 
might be treated differently on different computers. Use “01/MAR/2004” or check dates after the import if #1/3/2004# format is 
used. 

 

 

 



Two out of the next three are needed for import 

Column Name Date Note 
Last Test Date Any Date   
Next Test Date Any Date   
Frequency eg monthly/yearly   

There are three scenarios with supplying dates. 

Scenario 1: Last Test Date and Next Test Date are supplied.  Frequency of testing id calculated as difference between dates 

Scenario 2: Last Test Date and Frequency of testing supplied. Next Test Date is calculated as Last Test Date + Frequency 

Scenario 3: Next Test Date and Frequency of testing supplied.  Values are stored and Last Test Date is NOT calculated. 

Scenarios are evaluated in order 1 to 3 and the first valid combination is accepted. If no valid combination is detected, the dates 
and frequency are not imported. This and other errors are shown in a log file located in LogFiles folder. LogFiles folder is in the 
same directory as WinPATS™ task 
  

Screen1 

 

Screen 2 

 

Screen 3 

 

Screen 4 

 

To find WinPATS™ folder 

• Start > Search (Screen 1) 
• Search for All files and folders  (Screen 2) 
• Enter WinpatsLite.exe into search field and click search  (Screen 3) 
• When file is found, right-click and select Open Containing Folder (Screen 4) 

Column Name No of Characters Note 
Description 30   
Make 30   
Model 30   
Serial No 30   
Comments 50 Import only allows 50 characters.  Database field can store more by being updated manually 
Asset No 10   
Status 1 Value allowed: P for Pass, F for Fail 
Test Category 30 See Note: 

Note: Import can link equipment to an existing test category.  Category must exist or it is ignored.  Before import, populate 
database with test categories.  This can save significant manual import. 

 

 

 



Importing The Data 

Screen 1 

 

Screen 2 

 

Screen 3 

 

Screen 4 

 

To Import data: 

• Go to Administration > Import CSV (Screen 1) 
• Specify the full path of data to be imported. You can type in the file with path or click on the  

button with three dots (Screen 2) 
• Locate file and click open (Screen 3) 
• Click Validate Import Data (Screen 4) 

Validation Stage 

During the validation process records are read and all fields are evaluated to comply with database specification. When an error 
is encountered, the user is given the option on how to resolve the situation.   

Validation on Number of Fields 

Records containing fewer fields than in headings (Screen 1):  When the program detects fewer fields in the records than in 
the headings (line 1), the user is presented with several options. 

Screen 1 

 

1. Accept This Line: If fields are missing at the end of the line, the record is still good valid and can be imported.  It is up 
to the user to decide if the record is OK by visually examining content in fields.  It is recommended to note the line 
number on import form and choose the Skip This Line option.  When all error lines are noted and skipped, data can 
review at the source, e.g. open CSV file in Excel.  

2. Skip This Line: This option allows the user to ignore records that contain errors.  This is used to find all errors during 
the validation stage.  

3. Skip All Errors: This option removes all records with any kind of detected error.  The counter on the import form shows 
the number of lines in the CSV file and the number of records loaded into memory arrays.  The difference between the 
counters shows the number of lines that have been skipped.  

4. Terminate: Skips the latest error line and does not continue to read and validate data from the CSV file.  The records 
loaded counter shows the number of validated records able to be posted to the database.  

Records containing more fields than in headings (Screen 2): This is usually a result of source data containing a comma 
inside a field and not enclosed within double quotes.  An extra field potentially shifts content to different fields which results in 
relocation of information.  The program cannot deal with such problems and will not accept this line.  The options work as 
described above. 

Screen 2 

 

Field Content Validation 

Content of each field is validated. As most of the fields are alphanumeric, text the scope of validation is limited to detection SQL 
reserved characters.  The following 13 characters are not allowed: " *  '  %  =  !  [  ] < > ? # | 



Fields holding a date are validated to contain a valid date. When an error is detected a description is shown for the user to note 
and decide how to proceed. 

During validation process the mouse pointer changes into hourglass. On completion the hourglass changes back into normal 
mouse pointer and Commit to database button becomes enabled. 

Commit To Database 

Before importing data to the database, the user can visually review the records for import. Counters are showing the number of 
lines in import file and the number of validated records loaded into memory (Screen 1) 

Screen 1 

 

After clicking Commit to Database, records in memory are one by one inserted into the database. If a record fails to insert, it is 
skipped and noted in a current log file. 

  

Close Database 

  

Screen 1 

 

To close an opened database, go to the File menu and click [Close Database] (Screen 1)  

Exit Database  

   

Screen 1 

 

To exit a database click File > Exit (Screen 1).  Alternatively, use the button in the top right hand corner of the screen. 

Backup Database  

To learn how to use the backup function and backup features click here. 

  

 



Dispose of deleted  

This feature will remove the records from the database that have been selected for deletion. If an item in the equipment inventory has been 
deleted (right click and delete) then the record is placed in a site called deleted. This feature behaves much like the recycle bin on a PC. Items 
in the deleted site can be undeleted at any time. The site deleted can be selected from the quick site filter drop down box.  

The hide deleted equipment option under quick filter menu can be toggled to show or hide the deleted equipment in the equipment inventory. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Adding Equipment 

     For Test and Print Pack Owners (TnT memory)       

Your tester has been set up to work without the need of a PC with WinPATS on site. All sites and equipment are added using 
the keyboard and scanner. When the equipment is downloaded from the tester all sites and locations will be created 

automatically. 

Adding equipment as described in this page is only useful if you have any pre-existing data from spreadsheets and other 
sources. Once it is imported into WinPATS the data can be modified then uploaded to the tester. 

See the TnT Memory section in the TnT manual for more information on adding equipment. 

                                                                                     

  

Category Icons 

Equipment 
Inventory 

 

Test 
Results 

 

Test 
Categories 

 

Sites 

 

Batches 

 

Filters 

 

Users 

 

The above 7 icons allow the user to setup categories and information bases specific to each menu title.  

Function Icons 

Add 
Information 

 

Delete 
Information 

 

These icons allow the user to Add/Delete any item within all of the above categories. 

Use of Functions - Example 

(Left hand top of screen) 

To add a new piece of equipment: 

 
+ 

 
= 

 
Click to enlarge  

 

 



Sites 

BEFORE STARTING:  It is necessary for Sites (& Locations) to be set up before any other information in WinPATS™ can be 
input. 

A Site is considered as being a ‘place’ or ‘area’. A unique site name identifies a specific building, place or property. It doesn’t 
matter whether it is a 20 storey building or a 1 room office. What is important to remember is that the ‘Site’ name is unique to 
one ‘place’ only. It can be identified by its’ physical location ie. its’ street address, or suburb etc. to avoid confusion if there is 
more than one location being tested.  

A Location is an area within a Site. For example. ‘Charlie’s Office’ is a Location within a Site called ‘BMP Production’. 
“Reception’ may be another Location within this same Site ‘BMP Production’. It is expected that there will be multiple ‘Locations’ 
within one ‘Site”.  

1. To Add New Site  

Click 
  

= 

Screen 1 

 

a. Tab 1 - Contact Details (Screen 1) 
Enter a unique name in the Site box 
Enter in Address, Contact, Ph No1, Ph No2, Fax No and Email  

Screen 2 

 

Screen 3 

 

b. Tab 2 - Locations (Screen 2) 

Click to bring up the New Locations window (Screen 3) 
Enter a unique location in the New Location box, click Add to List 
Enter as many locations as required 
If a mistake is made, highlight the error and click Remove 
When all locations are correct and have been added to the click OK 
   

c. To Assign a Location 

Highlight the required location from the Available Locations list, click to assign 
Double clicking will also assign 
   

d. To Edit a Location 
Highlight the required location from the Available Locations list 
Click Edit Location 
Type in New Location name, click OK 
This will change the location name throughout the entire database 
   

e. Button Functions  

 
To transfer selected location names from the Available Locations list to the Assigned Locations list 

 
To transfer selected location names from the Assigned Locations list to the Available Locations list 



 
To transfer all location names from the Assigned Location list the Available Location list 

 
To add New Location/s 

f. Tab 3 - Comments (Screen 4) 
Use this tab to record any additional information that you may have.  Once all information has been added, click OK| 
The site will now be added to the Site list in your New Database  

Screen 4 

 

NOTES: 

1. There must be at least one Site setup for WinPATS™ to function normally.  
2. Location/s within the Site Details must be added to be able to continue with any tests.  
3. Locations required must be in the ‘Assigned Locations’ list and not the ‘Available Locations’ to be available when adding 

equipment.        
4. In the Locations list, you can select multiple locations by holding down ‘Ctrl’ and selecting the required location/s. 

Selected Locations will be highlighted in dark blue.  
5. On the locations tab, all typing will be recorded in capitals. (this is not the case in some of the other tabs/boxes).   
6. Double clicking a location in the ‘Location Name’ list will transfer it to the ‘Assigned Locations’ list.  

Equipment 

To add a single piece of equipment with an existing barcode 

Click 
  

= 

Screen 1 

 

Alternatively, you can click the Barcode Search box in the main database window and scan or type a barcode in (if entering by 
hand, hit enter when done).  If they barcode is new to the database, you will be asked to add new equipment, click yes.  If this 

question does not appear, barcode has already been used.  If you are sure the equipment is new, click   on the toolbar. 

1. General Tab (Screen 1)  
i. Enter in equipment details (Site, Location, Description, Make, Model, Serial No, Frequency)  

ii. Set the testing frequency  
iii. Click Show Test Types and select relevant tests from the Available Test Categories Column. For information on 

each test category see the test categories section.  

Screen 2 

 



2. Testing Tab (Screen 1) 
This tab allows tests to be selected for the equipment needing to be tested. Choose test/s to be done for each piece of 
equipment.  View the Available Test Categories in the right column.  By holding down the Ctrl key you can select 

multiple tests.  Selected Test Categories will turn dark blue.  Click the assign button to move test to Assigned Test 
Categories column, double clicking the test will also assign it.  If you make a mistake, select the test and click he 

remove button .  You can assign the same test twice if needed, for example, a power board may require each power 
point to be tested with the same test category.  When all desired tests are in the Assigned Test Categories column, click 
Add.  You will return to Screen 1.  

To Add Single or Multiple Equipment and Generate Barcodes Automatically: 

• Turn on the Auto Generate option (if not already on) in the WinPATS™ option screen  
• Click Equipment on the main screen toolbar  
• Click on the toolbar  

Screen 3 

 

If You Intend To Print Labels For All Added Equipment: 

• Tick the Print new to service box (Screen 3)  
• Enter details and assign test categories as you would normally  

Screen 4 

 

To Add Multiple Equipment 

• Click the Multiple option (Screen 4)  
• Enter the number of items you want to add  

Note: All details entered will apply to all equipment.  You can only use Multiple Add for equipment that is the same in every way, 
apart from barcode.  Serial No. and Asset No. only apply when adding single equipment. 

Note: For more information regarding Testing Categories, refer to Test Categories  

 

 

 

 



Test Results 

Test Results 

 

Test 
Categories 

 

Before you can start testing, Test categories and assignment of equipment needs to be set up in your WinPATS™ program.  

1. Test Categories  
2. Types of Test (per similar item)  

Test Categories 

A Test Category is a list of practical tests (or Test Types) to be performed on equipment, and the associated Upper and Lower 
Limits.  Former WinPATS™ users may have known them as Equipment Types. 

The test categories page consists of group tests and individual tests. When creating new pieces of equipment you can select 
from either of these. There are many test categories however there are only a few that will be used frequently. The most 
frequently use categories are listed in the first section. 

  

Commonly Used Test Categories: 

In Built Test Categories Manual Trigger on TnT+ Description 
TNT_CL1 F1 Key Class one, Earth bond & Insulation Test @500Vdc (default) 
TNT_CL1_SRG F1 key Class one, Earth bond & Insulation Test @250Vdc 
TNT_CL2 F2 Key Class two, Insulation Test only @500Vdc (default) 
TNT_CL2_SRG F2 key Class two, Insulation Test only @250Vdc 
TNT_EXTLEAD F3 Key Extension lead test, Earth bond, Insulation @500V & Polarity tests 
TNT_EXTLEAD_SRG F3 key Extension lead test, Earth bond, Insulation @250V & Polarity tests 
TNT_LEAKAGE Menu 2, F2 Key See leakage section below. For El, Plus and 3PL models only. 
TNT_RCD RCD Menu, F1 Key See RCD section below. For Plus and 3PL models only. 

  

Leakage Test Categories: 

Caution!! All leakage tests apply power to DUT. 

In Built Test Categories Manual Trigger on TnT+ Description 
TNT_LEAKAGE_CL2EXT Menu 2, F2 Key For class 2 devices. Pass level of < 1mA. 

TNT_LEAKAGE_RCD Menu 2, F2 Key If appliance has RCD mains plug installed. Performs an earth 
test then a leakage test. Pass level of < 2.5mA. 

TNT_LEAKAGE_CL1 Menu 2, F2 Key For class 1 devices. Performs an earth test then a leakage 
test. Pass level of < 5.0mA. 

  

 

 



RCD Test Categories: 

In Built Test Categories Manual Trigger on TnT+ Description 

TNT_RCD_TRIP_TM RCD Menu, F1 key RCD trip time test based on the RCD settings in the WinPATS 
options (file menu ---> options). 

TNT_RCD_TRIP_TM_10 RCD Menu, F1 key Preset 10mA test, RCD trip time test for 10mA RCD devices. 
TNT_RCD_TRIP_TM_30 RCD Menu, F1 key Preset 30mA test, RCD trip time test for 30mA RCD devices. 

TNT_RCD_CUR_RMP RCD Menu, F2 key RCD current ramp test. Increased RCD leakage current till trip 
current level is found. 

  

Other Test Categories: 

In Built Test Categories Manual Trigger on TnT Description 

TNT_POWER_TEST Menu 2, F1 Key (TnT+ Only) Caution!! Applies power to DUT. Measures Volts, current, PF, Watts, 
VA,  of DUT whilst in operation 

TNT_LOG_POW_TEST Computer Trigger only 
Caution!! Applies power to DUT. Performs a continuous power test 
with the result logged by the computer. Power log test setting defined 
in WinPATS options menu. 

TNT_CL1_eIM F1 key Class 1 test to medical standards. Not applicable if TnT is not designed 
for testing standards. 

TNT_CL2_eIM F2 Key Class 2 test to medical standards. Not applicable if TnT is not designed 
for testing standards. 

TNT_CL1_SRG_eIM F1 key Class 1 @ 250V insulation test & tested to medical standards. Not 
applicable if TnT is not designed for testing standards. 

TNT_LEAKAGE_eIM Menu 2, F2 key Leakage test to medical standards. Not applicable if TnT is not 
designed for testing standards. 

  

Test Categories (Single Test): 

Most test categories used are a combination of tests. For example, a class 1 test consists of an earth bond and insulation test. If you want to 
use the individual tests for your test category then choose one from the list below. 

In Built Test Categories Manual Trigger on TnT Description 

TNT_VISUAL Computer Trigger only Brings up the visual check box when testing appliance. Usefull for 
asset management. 

TNT_EARTH Computer Trigger only Earth bond test. 
TNT_INS250 F2 key 250V insulation test 
TNT_INS500 F2 key 500V insulation test 
TNT_POLARITY Computer Trigger only polarity check 

TNT_EARTH_eIM Computer Trigger only Earth bond test to medical standards. Not applicable if TnT is not 
designed for testing standards. 

TNT_LEAKAGE Computer Trigger only Performs a leakage test  with a pass fail <5mA. 

  

 

 

 



3PL Test Categories - Only for 3PL TnT Models: 

3PL TnT models can also select the previously listed test categories to do single phase testing. 

In Built Test Categories Manual Trigger on TnT Description 
TNT3P_CL1 Menu 3, F1 key 3 phase class 1 test. Earth bond & Insulation Test @500Vdc (default) 
TNT3P_CL1_SRG Menu 3, F1 key 3 phase class 1 test. Earth bond & Insulation Test @250Vdc 

TNT3P_EXTLEAD Menu 3, F2 key 3 phase extension lead testing. Earth bond, Insulation @500V & 
Polarity tests 

TNT3P_EXT_SRG Menu 3, F2 key 3 phase extension lead testing. Earth bond, Insulation @250V & 
Polarity tests 

TNT3P_4PIN_LKGE Menu 3, F3 key 4 Pin appliance, Leakage test with the _CL1, _CL2 & _RCD test 
category type. See leakage test categories for details. 

TNT3P_5PIN_LKGE Menu 3, F3 key 5 Pin appliance, Leakage test with the _CL1, _CL2 & _RCD test 
category type. See leakage test categories for details. 

TNT3P_RCD1_CUR_RMP RCD Menu, F2 key RCD current ramp testing with _RCD1, _RCD2 & _RCD3 phase 
selection. 

TNT3P_RCD1_TRIP_TM RCD Menu, F1 key RCD trip time testing with _RCD1, _RCD2 & _RCD3 phase selection. 

  

  

Adding a Test Category 

Screen 1 

 

  

Please note that new test categories can be created however they may not function with the appliance tester. This is 
because the TnT appliance tester needs pre-defined test procedures. If you make custom ones then the unit may not 
understand. 

It is ok to modify the upper and lower limits of the test categories or any other variable. Doing this will still allow the test to be 
executed on the TnT tester. 

• Click on the main screen toolbar  
• Click  
• The Test Category Details window will appear (Screen 1)  
• Enter a unique name for the new Test Category  
• View the Available Test Types on the right and click the relevant tests to assign.  By holding down the Ctrl key, you can 

select multiple tests.  Selected Test Types will turn dark blue.  

If a Test Type you require is not available, or the name is correct but the unit of measure is wrong, you will need to add more 
Test Types 

• Click  
• The Test Categories window will appear  
• Enter a name for the new test type (e.g. Visual)  
• Select the appropriate UOM (Unit of Measure) from the right column  

 



 

If you do not see the UOM you want in the list 

• Enter a new one  
• Click Add to list  
• Repeat this process for as many Test Types as you wish.  Several Test Types can have the same name but their UOM 

must differ  

If you make a mistake 

• Select the Test Type from the list, click Remove  
• Click OK when all new Test Types have been added  
• When you return, the new Test Type will be automatically assigned to the new Test Category  

To assign the Test Types selected on the right    

• Click to assign.  Double clicking will also assign  
• The order of the Assigned Test Types is also the order that tests will be performed in  

To change the order of test types 

• Select single or multiple Test Type/s  

• Click the Move Up or Move Down buttons as needed  
• Click OK when done  
• The new Test Category will appear with the other Test Categories and can be assigned to equipment  

Converting Old Test Categories 

If you are going to use a TnT(+) to test equipment when you previously haven't, you may need to migrate to TnT Test 
Categories.  For example, you used to use an Equipment Type called CLASS1 but now you will be using a TnT(+) for testing. 

Screen 2 

 

To Convert a Test Category 

• Click Test Categories on the main screen toolbar  
• Double click the old Test Category (e.g. CLASS1)  
• The Test Category Details screen will appear  
• Tick the Migrate to Another box and then select the TnT Test Category (e.g. TNT_CL1) (Screen 2)  
• Click OK  
• Click Yes to the confirmation message  

• All equipment formerly tested otherwise will now be tested by TnT(+)  

To delete the old Test Category, if desired 

• Simply select the Test Category (e.g. CLASS1)  
• Click Delete on the main screen toolbar or right click the old Test Category and choose Delete  

The test categories provide by this program are designed specifically for the TnT &TnT+ units only. Additional test categories 
can be created but they can not be control types for test equipment. Test Created type codes can be developed for  inspection 
programs and checking procedures when used with PDA’s or PC/Laptops. Eg. Exit Lighting tests, Anesthetic Equipment 
maintenance and inspection. 

 



To Setup Tests 

To set up procedures of testing and controlling a TnT or TnT+ appliance tester, select the General Tab on the Equipment 
Details screen and select the frequency of test from the drop down number and units box. (Screen 3) 

Screen 3 

 

Screen 4 

 

(For more information regarding equipment setup, please refer to the equipment section ).  

Select from the available test Categories box the required test for the DUT (Device Under Test).  This be can done by clicking 

on the desired test type then clicking the   Arrow button.  Sequential testing can be created by taking across multiple test 
types by clicking on desired test type press & hold CTRL key down then continue to select require tests types. (Screen 4) 

The tool bar at the top indicates the Barcode number of the (Device Under Test).  If the test type required is not on the list, 

further test types can be created from the test categories menu. ,  ,  (Screen 4) 

Screen 4 

 

Screen 5 

 

A safety interlock for Item using a specific test type is in place.  If test type is no longer in use this Safety catch would not be 
displayed and the test type would be deleted. 

Batches  

Please note: Wavecom no long supports Pocket PC devices. The information is only provided for old appliance testers. 

Batches are a powerful tool for delegating work to someone else.  A batch database is a child database that belongs to the 
parent database that made it.  Administrators selectively can decide how much a Batch inherits from its parent.  Batches are 
sent away and eventually come back and are ‘Restored.’  When Batches are restored, the parent database will add to itself 
anything new in the Batch – Sites, Test Categories, Equipment and Tests but not Users. 

Assigning A Batch 

• Click on the main screen toolbar  
• Click  
• The Batch Assignment screen will appear  
• Choose an existing User to be the Batch Administrator  

• Choose the appropriate Platform  

For PC platform the Batch Administrator will have a similar job and rights as an Administrator on the parent database.  They can 
add Users, for example, to the Batch database.  The Batch Administrator will also be the first required User ID for logging on to 
the Batch.  The password will be [Password] and the Administrator will be required to change it. 

 

 



For Pocket PC platform the Batch Administrator will be the User of the Pocket PC. 

• Double click any Available Sites to assign them to the Batch  

Assigning a Site to a Batch means that the Batch will inherit any Locations, Equipment (and tests for PC platform) in that Site.  It 
is better to assign required Sites only, particularly for the Pocket PC platform.  It is not mandatory to assign any Sites.  All 
Batches will automatically inherit all Test Categories. A filter must be created before a batch can be assigned (for help regarding 
this please contact Technical Support).  

• Select the date the Batch is due back  

If you are assigning a Batch to Pocket PC 

• Ensure the Pocket PC is connected t the Computer and the Active Sync icon is green  
• Click OK  

If you are assigning a Batch to PC 

• Select a file location and enter a name for the new Batch database  
• Click open  

It is strongly suggested you create a ‘Batches Out’ folder to put all created Batches, and that you give each Batch a unique and 
meaningful name.  Then give a copy of the Batch database to whoever requires it.  DO NOT give out multiple copies of the 
same Batch database, make another Batch instead. 

Also create a ‘Batches In’ folder to put Batches in when returned.  It is important to keep Batches ‘Out’ and ‘In’ separate 
because they will likely have the same file name. 

After Batch is assigned, you will be asked to wait.  Depending on the speed of your computer, the size of the database, and 
the speed of connection to the Pocket PC, you will be waiting from a few seconds to a minute. 

Restoring a Batch 

• Ensure the Pocket PC is connected to the computer and the Active Sync icon is green  

• Click  
• Right click the row  
• Choose restore  
• Go to the Batch databases location  
• Click open  

   

Filters 

For information on filters see the filters page. 

  

Users 

WinPATS™ has two levels of users, Administrators and Testers.  The following rules apply 

Administrators can do anything, except 

• Delete or change in built Test Categories  
• Delete or lock out the last Administrator  
• Delete Test Categories in use  

 



Testers have limitations, they can 

• Create Equipment  
• Create Sites  
• Create Test Categories  
• Perform and View any Test  
• Edit any Equipment  

Tester Cannot 

• Merge/Import  
• View or manage Users  
• View or manage Bathes  
• Delete items they did not create  

  

Adding a User 

• Click on the main screen toolbar  

• Click  

Screen 1 

 

• Enter a unique name for the new User  
• Select a Group  
• Enter Details  
• Setting the Group to (None) will lock the user out of the system until changed by an Administrator  
• Click OK when done  

The new user will appear with the other users and can now log onto the current database.  When the new user logs on for the 
first time they will have [Password] as their password, and will be prompted to enter a new personal password.  WinPATS™ has 
2 levels of user, Main Administration level and a Testers level.  The Administrator level has the right, at all times, to add and 
delete items or test types etc. The Phone and e-mail details are for easy contact reference. 

  

Out of Service Option 

WinPATS™ now has the option of hiding equipment that has been deemed Out of Service.  This option can be accessed 
through the Quick Filter Menu (Screen 1) 

Screen 1 

 

 
 
 



 

Filters 

In WinPATS once the  database becomes large in size it can be hard to manage, this is where filters comes in. Filters have 
multiple uses in WinPATS however the most common use it modify the way the equipment inventory is displayed.  

Filters can do three main functions:  

1. Change the way the equipment inventory is displayed  
2. Change the layout of your COC (Certificate of Compliance)  
3. Change the way WInPATS handle batches.  

     

Screen 1 

 

  

In screen 1 the arrows point to the 3 filter locations.  

Quick filters only modify the equipment inventory. As soon as you leave the equipment inventory the filter is removed. To 

remove a quick filter simply click on the equipment inventory icon in the top corner.  

If a more permanent filter is required then select a filter from the filters page. Once this is set it will stay active until removed. 
Even if the database is closed.  

Quick Site Filter  

Selecting a site from the dropdown box will show only the selected site from the equipment inventory. See screen 1 for the quick 
site filter location.  

Quick Filter Menu  

In the quick filter menu there are 12 preset filters that change the display of the database. These are:  

 
Test sub-menu:  

Choose which tests results are displayed by there status. Clicking on this filter will take you to the test results page. Here you 
can see the individual pass / fail components of each record. For each piece of equipment there can have many pass fail 
attempts. In WinPATS it is only the most recent test that counts as the result. Select between all, passed, failed and null. Null 
simply means items that have not been tested yet.  

   

 

 



Equipment sub-menu:  

This filter will sort records in the equipment inventory depending on their status. Equipment is sorted by the status column in the 
equipment inventory. Select from all, pass, fail, new to service, testing due and testing due in a month. New to service means 
the item has been created but has not been tested. Testing due is a simple way of see what is needs testing. To use specific 
date ranges on testing due, click here. New to service items will show in the testing due filter.  

   

Batches sub-menu:  

If there are batches in use selecting the all filter will just show all created batches. When batches are created they have a due in 
date assigned to them by the user. Selecting outstanding filter will show this.  For more information on batches click here.  

   

Filters Page  

If you need a more precise filter or need a filter that is permanent then select a filter from the filters page. Initially this page will 
be blank but once a filter has been created they will be kept in a list for later use. These filter presets can be activated or 

deactivated but only one of each filter type can be used at a time. To begin go to the filters icon and select the add icon .  

   

Screen 2 

 

1. Give the filter a name. This is just a reference name and does not effect the way the filter behaves.  
2. From the drop down box "applies to" select from the 3 options. Selecting batches will determine what data is added to a 

batch file. COC (Certificate of compliance) needs a filter to determine what sites are shown on the report. Main grid just 
simply means equipment inventory. Whatever filter settings we apply here will effect the equipment inventory.  

3. Choose how the filter behaves by selecting 1 of the 3 options in INCLUDE. Choosing all sites will not filter out the sites. 
Selecting sites will show the site listing in screen 3. Move 1 or more sites to the selected sites box using the arrows in 
the middle. The third option is to select specific locations inside. This will narrow down your filter to show equipment  in 
selected locations. Select site from the drop down box before you can choose the individual locations. See screen 4.  

   

Screen 3 

 

Screen 4 

 

4. If a date range filter is needed select the tick boxes next test date range or last test date range. Once ticked select the 
date range from the drop down calendar.  

5. Choosing the description drop down box will filter out all records with the same description. The drop down box listing is 
created by complied list of the equipment inventory.  

6. Status drop down box will filter out records based on the status of the record.  



7. Frequency filter will show only the records with the same matching test frequency.  

When finished click OK to complete. The newly created filter will be shown in the filters list. If you have multiple filters of the 
same type they can be activated by right clicking on the filter and selecting this option. Note only one filter can be active per filter 
type. To modify an existing filter double click on the filter name. Main grid filters that are active are identifiable by the purple 
circle in the equipment inventory. To deactivate this filter click on the purple circle. See screen 5. 

  

Screen 5 

 

  

  

 

 

 

 

 

 

 

 

 

 

 

 



Reports 

WinPATS™ currently supports three kinds of reports; 
i.              Fixed reports are standard reports with fields and formats fixed.  
ii.             Flexible reports allow the user to select fields and adjust the width of each individual field. 
iii.             Custom reports allow the customisation of format, the inclusion of logo(s) and various user specific information. 

  

Note. When generating a report for the first time make sure that the report preview looks correct. Reports can be displayed 
incorrectly if the Windows printer is the wrong type or set incorrectly. For example if the default printer is set to a non A4 paper 
size the report preview will come out differently than the A4 preview. All reports are based on the A4 paper size.  

If no windows printer installed and the report preview is correct then leave it as it is. If there is a problem please install a printer 
in printers and faxes. You don't have to have a physical printer just the printer driver installed on the computer that can print A4. 
Please make sure the printer is configured correctly in WinPATS options. Click here for details. 

  

Fixed Reports 

Fixed reports show the same data as shown on screen. The ‘On Screen’ data is determined by the Main Grid filter. To report on 
one Site, you can create and activate a filter for the Site. However, there are exceptions. Certificates of Compliance requires it’s 
own filter. Please Note: Site, Location & User Reports do not use filters. 

Site & Location Reports 

This report lists all Sites and associated Locations. Identical location e.g. Workshop can be associated with different sites and 
all valid Sites & Locations are shown. Each site is listed on a separate page. The User can select a particular Site by printing or 
exporting the relevant pages of the report. The default format is A4 portrait 

An example of a Site & Location Report is shown below (Screen 1) 

Click images to enlarge 
  

Screen 1 

 

Equipment Summary Reports 

This report shows selected fields from the Main grid display. The default format is A4 portrait. 

Screen 2 displays standard summary, screen 3 displays detailed summary 
  

Screen 2 

 

Screen 3 

 

 



User Reports 

This report lists all Users that have been entered into the database, including contact details 

Certificate of Compliance Report 

The Certificate of Compliance can be produced for any Site. When invoked the form allows for customisation of certain parts of 
the certificate. 

All fields can be modified by the User. The page margins are quite large to allow for printing on special paper with a frame or to 
be framed after printing. 

Example of report shown in Screen 4 
  

Screen 4 

 

Flexible Reports 

This facility allows Users to choose most of the fields from the main grid and adjust width of fields as needed.  

User selected data can also be exported into CSV (comma separated values) file. 

  

Screen 1 

 

When invoked the form shows a list of already configured reports. To create a new one enter a name into Select Report Layout 
e.g. “New Report” and Click Load/Create Layout button (Screen 1)  

  

Screen 2 

 

The list of all available fields is displayed. Site and Location fields are not optional fields.  To include fields in the report, move 

fields from the left list into the right list by double clicking or selecting and using button with sign.  The position of a field in a 

page can be moved by selecting a field and moving Up or Down by clicking the and buttons. (Screen 2) 

Clicking Save Changes will create or overwrite file New Report.rst. File is stored in Reports folder under WinPATS™ directory. 
Files with RST extension can be deleted if needed. e.g. when too many are created and not used. Save As action can be 
repeated, the file is always overwritten without questions. Save As records always the latest status. As the following form can 
also modify layout of the report it is necessary to save the layout before cancelling this form.  To see the report fields layout click 
Next (Screen 2). 

  



Screen 3 

 

When a new report is displayed for the first time it will be displayed with default size fields with no other options specified. 
Column width can be adjusted by clicking and dragging. Double-click on column border will adjust width to display fully all data 
in a column. To move columns around go back to the previous form and change the order of selected fields. Column 
adjustments are remembered while going back and forth. 

Custom Reports 

The Custom Report option is provided to cater for specific report requirements, e.g. custom page headers and footers. Custom 
reports are stored in files with RPT extensions. All *.RPT files can be deleted if not used. When selected, the report connects to 
the currently active WinPATS™  database. By using parameters a user can interactively select what is needed. 

When selecting a custom report the user is shown the selection of parameter values. The number of parameters vary for 
different reports. Only parameters specified in the report must be specified. Our example requires 5 parameters. (Screen 1)  

When selecting parameters select value(s) and Add. There are several ways to specify parameters. 

  

Screen 1 

 

   

Printing Reports  

To print a report:  

1. Generate a report from the reports menu.  

2. Click on icon (screen 1).  
3. Check the printer is the correct default printer.  
4. Choose the page range. All or specific pages. Select the number of copies to print. Click Ok.  
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Exporting Reports  

Exporting reports allows the generated report to be saved in 16 common file formats. From here the report can saved as a file 
for safe keeping or sent to the client. Using the export function may be preferable to save many pages of paperwork.  

Tip. Flexible reports allow reports to generated in a variety of ways.  The report may not be exactly what you are looking for. If 
so, then the report can be exported to a common word processing software and be modified. For example, once the report is 
exported a company logo can be added to the top of the report.  

To export a report:  

1. Generate a report from the reports menu.  

2. Click on the icon (screen 1).  
3. Choose the file format required and leave destination as disc file (screen 2 & 3).  
4. Select the page range, all or specific range (screen 4).  
5. Choose the save location, click on the save in drop down box and choose the drive and folder. Enter a name for the file 

in the file name box (screen 5).  
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Administration Functions 

This page cover all items on the administration menu  located on the top bar. This menu is only visible if the user is logged in as 
an administrator. If the current user is logged in as a tester then this menu won't be shown. Your version of WinPATS may not 
have all items listed here depending on your WinPATS version.  

Some of these commands in the administration menu can damage the database when used improperly. Please make sure you 
have a backup of your database before using any features. Click here to read about backups.  

   

Import CSV  

To learn about importing CSV files click here.  

   

Register Tester  

This will be implemented in future versions of WinPATS. This feature is designed to handle other appliance testers.  

   

Utilities - Change Barcode Digits  

If your database is using a barcode system with leading zeros you can change the number of digits or the length of the barcode. 
This function modifies all barcodes in the equipment inventory.  

     

Screen 1 

 

Current number of digits are shown in the top box and the new value is placed in the box below. This value can be higher or 
lower than the current digits value.  

Warning The barcode is a reference number to the item. If you change the barcode in the software it won't recognise the 
barcode when you scan it.  

Be careful when adjusting the number of barcodes. Do not adjust beyond the leading zeros or it will remove barcode values.  

   

 

 

 

 



Combine Locations  

   

Screen 2 

 

This feature can combine multiple locations into 1 location. To do this move the locations listed in the right box to the left using 
the middle arrows. The location listed on the top will be the combined location name once done.  

In Screen 2 the two locations boardroom and business centre will be combined and the result will be boardroom location. Click 
combine button to combine the locations.  

   

Combine Sites  

Same as the combine location function but able to manage sites. This function is useful if you have multiple TnT memory testers 
and you are working on same site names. Often the site name can be incorrectly worded and will appear as two different sites 
once downloaded. Use this function to correct this.  

   

 Combine Descriptions  

Allows group renaming of the descriptions field. This is useful if a number of equipment have the same description but some are spelt 
incorrectly. Useful for correcting downloaded records from the tester when 2 or more testers incorrectly spelt the same description name.  

   

Remove Duplicate Equipment  

Scans the whole database and checks if there are multiple entries of the same item. This occurs when records have the same 
barcode, site and description. This function does not normally need to be used unless something has gone wrong with the 
database such as bad import merge.  

   

Resolve Equipment  

Only applies to TnT memory units. 
Allows users to resolve data from an old version of WinPATS (< version 3.1.30). This function replaced the "resolve data" under 
the download menu. If you are using WinPATS version 3.1.30 or greater then is does not apply to you. This menu item will 
disappear if there's no records to resolve.  

   

 

 



Restore Test Categories  

Only applies to TnT memory units. 
Choose this option if the auto tests are not functioning once the records are uploaded to the tester. This problem may occur if 
you have imported your database from a CSV file. There is no feedback once this menu function is run.  

   

User Password For Logon  

Administrators can choose if the database uses passwords when logging in. Here this function can be switched on and off. 
Please note if you switch this function off then all other users will not be required to use passwords when logging in. If you are 
worried about other users switching off password protect then the other user should not be a administrator. They should be a 
tester under the users page. To learn about users click here.  

   

Perform Archive  

This will move all the old equipment that is no long being tested to an archived database file. A date range is chosen to select a 
cut off point for the archived records. WinPATS will move all records with next test due dates older than this date. For example if 
2 years is chosen then all equipment with the next test due date older than 2 years from the current date will be archived.  

   

Backup options  

   

Screen 3 

 

The backup options can be found under the file menu. These options modify how the backup function to behaves. This feature 
may not be available in older versions of WinPATS. If so make a backup using the backup database function in the file menu 
before attempting anything from the administration menu.  

By default the backup feature under the file menu is switch on. This makes a copy of your database on every open. The 
locations of previous backups under C:\WinPATS MX (default install folder) Open your WinPATS Mx folder and open the 
backup folder.     

This feature should not need to be altered because it is already set optimally on installation. If you are using WinPATS over a 
networked system you may like to choose a different backup path. It is a good idea to leave it on automatically backup and on 
database open before any changes have been made to the database.  

Note. It may be necessary to periodically delete the backup databases if you have computer with limited disc space. Most 
modern computers come with plenty of free disc space so this should not be a problem.  

   

 

 



Backup Database  

This is not the same a backup options. Here you can make a copy of you database to a select destination. This maybe on an 
external media such as a flash memory stick.  
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1. Choose the destination of the backup database. Click the "look in" drop down box and select the appropriate drive. 
Select removable disc if you want to save to a flash memory stick.  

2. Enter a file name for the backup database and click save.  

 

 

 

 

 

 

 

 

 

 

 

 

 



Troubleshooting 

Frequently Asked Questions  

1. When I attempt to create a new database, a logins screen appears asking me to enter a password 
 
If you are using an older version of WinPATS the initial password for a new database is password.  After this has been 
entered successfully, you will then be prompted to enter a new password.  Passwords must be at least 7 characters 
long 
   

2. How do I use WinPATS™ Lite to test with the TnT appliance tester? 
 
To use WinPATS™ Lite to test with the TnT Appliance Tester, you will first need to assign the COM port to which the 
TnT is connected to.  This can be done in the WinPATS™ Lite be going to File > Options.  Once the COM port has 
been assigned, you can perform a test by right clicking on an item in the Equipment Inventory database and select 
Perform Test(s).  The Visual Check screen will appear, once Yes is clicked the test will begin automatically. For more 
information see getting connected. 
   

3. When performing tests with WinPATS™ Lite, the TnT needs to be reset between each piece of equipment for 
the communication to work 
 
This is a known problem with Windows XP, as it does not fully support serial ports.  To solve this problem you will need 
to use a Serial to USB adapter which can be purchased from Wavecom Instruments (Part Number TNT-USBS). 
 
If you are not using Windows XP and experience this problem, try one of the following options:  

i. Use another available serial port on the computer  
ii. Use a Serial to USB adaptor  

4. When I attempt to create a new database I receive a message saying that I need to upgrade to WinPATS™ Lite 
 
WinPATS™ LiteBase  does not allow the user to create new databases.  You are only allowed to use the default database 
that comes with the installation. 
 
To open the default database, go to File > Open Database 
 
The initial password for the database is password 
   

5. When I attempt to view a report I receive a message saying that I need to upgrade to WinPATS™ Lite 
 
Some early releases of WinPATS™ Base 3.0 did not allow any of the reporting features to be used.  To fix this problem 
contact Wavecom Instruments for further information. 
   

6. When trying to merge user receives error: Merge Fail-Application Files in use? 
 
This error is displayed when program cannot make copy of database over the file Backup.wdb or Inter.wdb. This 
happens when files have attribute Read Only set.  

 Please do the following: 

-Locate the WinPATS™ directory to find these files 

-Right click on the file and select properties 

-Un-tick the read only box 
   

7. When in options menu I get an error "Runtime error 13: type mismatch" when I click on OK? 
 
This error occurs when entering the incorrect data type into a field. For example if the program requires a numerical 
string and an alphabetical string is provided this error will occur. It can also happen if no data is provided. The most 
common occurrence is in the options box. There is blank dropdown fields in the options menu that have not been filled 



out. Please go though each page/tab and make sure these dropdown boxes are filled out, even if they don’t have any 
relevance to your computer configuration. By default installation these will be filled out. If they are not present check 
with you system administrator to see if restriction have been placed on the computer.  
   

8. When filling out my registration details and product key I get  "Runtime error 13: type mismatch"? 
 
Make sure that the fields are filled out correctly. Make sure the "Phone Number" and "product keys” are all numerical 
characters. 
   

9. When completing my registration details it displays “Reg error: contact vendor”? 
 
This maybe a once off message that you should ignore. If it occurs all the time then the computers settings may be 
incorrect. Most likely cause is the WinPATS™ program was unable to save your registration details or the name and 
phone number was incorrect in some way. Also please check that your computer does not have user restrictions set. 
Please check with your company IT manager to resolve this. 
   

10. When using WinPATS™ I receive an error message "Runtime error 339: "msccomct2.ocx may not be installed 
or correctly registered"? 
 
If you receive a message like this, it means that the WinPATS™ installation was not successful and some components 
were not installed. The user or administrator may have put restrictions on the user that is logged in at the time. Also the 
file may not be present for the installation, if so contact Wavecom Instruments for help. 
   

11. When printing a label a message appears" Runtime error 94: Invalid use of Null"? 
 
Database maybe corrupt in some way. It is trying to print out a null field (blank field). Possible causes are importing a 
corrupt database or importing badly formatted CSV file. Please contact Wavecom to solve this. 
   

12. When opening a database a message appears "Object variable with block variable not set"? 
 
This happens when a database from version 1.9.X is loaded in WinPATS™ version 2.0.X. Please create a new 
database in version 2.0.X and use the import merge function. 
   

13. When generating reports, I get an error "Runtime error 91: Object variable with block variable not set"? 
 
1. You may be running WinPATS™ under a different user than it was installed under. For example, User installs 
WinPATS™ under Administrator, logs off and then logs in as Tester and tries to generate a report. To fix this, reinstall 
WinPATS™ under every user that wants to use the program into the same installation directory.  

2. Security settings have been put in place which block certain functionally of the WinPATS™ program. Go to Control 
Panel > Administrative tools > Local security policy. Check that no rules block installation of files or loading and saving 
of components. Please do not change these setting unless you have permission from your IT manager first. 

3. Install a version of WinPATS™ 2.0.12 or higher. The installation wizard contains an install option to solve this 
problem. When prompted if this software is to be installed for one user or all users, select "all users".  
   

14. When generating reports the computer displays a message “head & footer is too large /small”. Or when 
generating reports it displays strange text or nothing at all? 
 
Please check to see what your Windows default printer is. To generate a report in WinPATS™ the program uses a third 
party program. When this report program generates the report it looks at the Windows printer preferences and takes 
them into consideration. If the printer settings are incorrect then the print preview will be incorrect. Please make sure 
that your Windows printer is set as the default printer and that it is capable of printing on to A4 paper. 
   

15. WinPATS™ will not print out tags when selecting "print label" in WinPATS™. The print status bar will go from 0 
to 100 percent then the computer does nothing? 
 
Make sure that the following things have been done: 

-Hardware switched on and plugged into computer. 

-Green light is on the front of the Zebra printer. 



-All 4 printer files (eg pass_p.wbl) have been added to options/printer dialog box. 
 
If you are using a COM or LPT port: 
 
Please check the BIOS settings to see if the printer parallel port settings are correct. This can be incorrectly set causing 
the printer not to print. Make sure that it has the following settings.   

Parallel mode: ECP / EPP 

Parallel type: LPT1 (sometimes set to auto which causes problems) 

Very occasionally notebooks like Toshiba have docking stations. They are long connectors with many pins & they can 
be used to connect many different devices. The trick with new notebooks is the docking stations ports can be used as a 
standard parallel port. If the docking station is not set to parallel port in the BIOS you will not be able to print at all. 
 
Selecting COM ports for label printing 
 
Note: If you are using a USB to serial device and have it plugged directly into the printer serial port, it will not work.  The 
Zebra TLP2844 printer is a programmable printer. To do this they require a two-way communication because the serial 
port shares the same pins and they need to be crossed (eg transmit to receive pins). The cable required to do this is 
normally referred to as a null modem cable or crossover cable. This cable is placed between the USB/Serial device and 
the printer. If you require one of these cables please contact Wavecom. 
   

16. When adding new equipment, WinPATS™ asks, "No barcode label selected would you like to do so?" If no is 
selected program crashes with "runtime error 5: Invalid procedure or comment"? 
 
Either Go into File > options > printing tab and fill out the printer status bars or make sure that "Print when done" is not 
selected in the new equipment dialog box. Also check that in options, print new to service tag is not selected.  
   

17. When performing a test I receive a message “None of the selected COM ports are available” Even if I know my 
COM port number? 
 
If you are using a USB to serial device, remove the device from the USB connector, wait a few seconds, then plug it 
back in. By doing this, it will re-initialise the device and also the communication port. 
 
If you have a Zebra Label printer:  

If you are receiving the same message for the notebook built in COM port's. Check you Windows printing setup (if 
installed). Go to “start > settings > control panel > printers and faxes”. Right click on Zebra TLP printer and select 
properties. Select the com ports tab and make sure the com port that you are using to communicate to your tester is not 
selected. 
   

18. WinPATS™ is unable to import CSV files successfully. All records were validated OK, no records were stored 
into database during "commit" stage or WinPATS™ is displaying many errors when in the validation stage? 
 
Please read the documentation on how to import CSV files on the CD.  This be found in the WinPATS™ manual. 
   

19. When opening a database a message is displayed "Error layout does not exist" and the database will not open? 
 
In file > options click on restore grid defaults. Then reopen the database. 
   

20. Cannot transfer batches to my PDA. WinPATS™ displays “transfer error”? 
 
Activesync 4.0 will not be able to transfer batches across because the mdb > cdb conversion function has been 
removed. This is a big problem for now because new PDA's only work with activesync 4.0 or above. Please do not 
install this version. Use versions 3.7 & 3.8. 

 If you have the correct versions please check the following: 

 -Check to see that the PDA cable is secure. 

 -Make sure that Activesync is synchronised with the PDA. 



 -On the PDA select Start > Settings > System tab > memory > applications running. Makes sure that WinPATS™ is not 
running by selecting “stop all tasks”. WinPATS™ cannot transfer a batch with WinPATS™ CE loaded. 

 -If you have a firewall make sure that it has not blocked the application “WinPATS™LITE.EXE”. If you receive a pop-up 
message about this you should allow this application. 

 -If the PDA is running erratic perform a soft-reset. 
   

21. The following error occurs when booting the computer: WCESMgr.exe - Application Error, application failed to 
initialise properly (0xc0000142)? 
 
If you have Symantec AntiVirus Corporate Edition please install the latest version. Any version 8 or under will cause this 
problem. The antivirus program and activesync seem to clash. This error message will occur on different versions of 
activesync. 
   

22. When trying to load a database I receive a message saying, "File does not exist"? 
 
WinPATS™ cannot edit the file because the file is read only. Most likely cause is the file is being loaded directly off a 
CD-ROM. Please copy the file to a local disk (C: drive) or some other drive that can edit files directly off the media. If 
you have copied the file to a local disc and you still receive the same message please do the following: 

 -Locate the database file. 

-Right click on the file and select properties. 

-Un-tick the read only box. 

-Select apply. 
   

23. When adding fields into WinPATS™ the program displays the message "Runtime error -2147217900 Syntax 
error" and the program closes down? 
 
When entering fields avoid using special characters (eg " [ ] @ & *). These characters maybe reserved for the program. 
For example if the description of an item is: 

 6 " angle grinder 

 This will generate the runtime error because of the use of quotations in the description. To solve this problem use a 
description, for example: 

 6 inch angle grinder 
   

Troubleshooting 

Screen 1 

 

1. If you get the error message shown above (Screen 1), you will need to upgrade to WinPATS™ Lite to be able to create 
a new database 
   

2. If the TnT appliance tester is not communicating with the PC, check that the COM port configuration in WinPATS™ is 
correct.  To do this, go to File > Options  

 



Printer Setup 

This is a quick guide to setting up the Zebra Label Printer that is used in conjunction with WinPATS™ Lite 

• Insert WinPATS™ CD into CD-ROM Drive  
• Go to My Computer  
• Double click drive in which WinPATS™™ is located e.g. (E:)  
• Double click folder called Zebra Label Printer  
• Double click folder called Drivers  
• Double click folder called Driver  
• Double click icon called ZUDv5007  
• A window should appear, click OK  
• A window should appear detailing where you want to unzip the drivers too  
• Designate a folder  
• Click Unzip making sure the box When done unzipping open: .\Setup.exe is ticked  
• Confirmation window should appear, click OK  
• A Language selection windows should appear, click OK  
• The Printer Setup Wizard should open, click next  
• A Printer Select window should appear, under Manufacturers select ZEBRA ZPL, and under Printers select ZEBRA 

TLP2844-Z  
• Click next, if a caution box comes up, click Continue Anyway  
• A Printer Port window should appear, select relevant port based on which connection is used,     e.g. USB = USB001, 

Parallel = LPT1, Serial = COM1  
• Click next and specify a name for the printer  
• Click next to start Configuration Assistant Wizard  
• Click next and specify Label Setup*  
• Click next and specify Top Adjustment*  
• Click next and specify Dispense mode*  
• Click next and specify Media Type*  
• Click next and specify Media Tracking*  
• Click next, then Finish  
• Click Print Test Page if desired or Finish to exit  
• Go to Start > Printers and Faxes  
• Right click on Zebra TLP2844-Z and select set as default  

* Settings are typically left as default, so no alteration is needed unless otherwise specified. 

Note: Based on Windows XP operation.  If the new hardware wizard appears, select No, not this time > Next > Install software 
automatically 

For more troubleshooting solutions, please contact WinPATS™ Technical Support @ Wavecom 
Instruments 

 

 

 

 

 



Additional Information 

Test Labels  

Please refer to your supplier for details regarding the purchase of appropriate tags and labels as well as other supplies and 
accessories 

 Optional Accessories 

TnT Portable Appliance Tester  Part No: WCM-TNT 
TnT-el Portable Appliance Tester Part No: WCM-TNT-EL 
TnT+ Portable Appliance Tester Part No: WCM-TNT+ 
TnT+P Standard with Software Part No: WCM-TNT+P 
WinPATS™ LITE Software      Part No: WCM-WinPATS Lite 
WinPATS™ CE PDA Software Part No: WCM-WinPATS CE 
WinPATS™ Software Upgrade Part No: WCM-WinPATUP  (dependant on specific upgrade) 
Blue Tooth Interface      Part No: WCM-BTHT 
WinPATS™ Scanner 232  Part No: WCM-1200 Scanner 25232 
WinPATS™ 1200 Scanner USB  Part No: WCM-1200 Scanner USB 
WinPATS™ PDA Laser Scanner Part No: WCM-PDA Laser Scanner 
HP IPAQ PDA Part No: WCM-HP IPAQ 
500mm Earth Strap Part No: TnT-ES 500  
ZEBRA Tag Printer Part No: WCM-Z2844 
3-Phase Adaptor 20A Part No: WCM-3Phase-20A 
3-Phase Adaptor 40A Part No: WCM-3Phase-40A 
3-Phase Adaptor Multi Part No: WCM-3Phase-M  
HBC Fuse  Part No: WCM-HBC10AM205 
Isolation Transformer for RCD testing      Part No: WCM-ISOT   
USB to Serial Adaptor      Part No: TnT-USBS   

Other Relevant Authorities 

New South Wales 

Work Cover NSW 
GPO Box 5364 
Sydney NSW 2001-0423 Australia 
Ph: (02) 4321 5000 

Department of Fair Trading 
Safety and Standards Branch 
PO Box 972 
Parramatta NSW 2124 Australia 
Ph: (02) 9895 0111 

Queensland 
Department of Mines and Energy 
Electrical Safety Office 
PO Box 69 
Brisbane QLD 4001 Australia 
Ph: (07) 3237 1201 
Tasmania 
Electrical Standards & Safety 
PO Box 56 
Rosney TAS 7018 Australia 
Ph: (03) 6233 7831 
Western Australia 
Office of Energy WA 



Technical and Safety Division 
20 Southport Street 
West Leederville WA 6007 Australia 
Ph: (08) 9420 5600 
Victoria 
Office of the Chief Electrical Inspector 
PO Box 262 Collins Street West 
Melbourne VIC 8007 Australia 
Ph: (03) 9203 9700 
South Australia 

Work Cover SA 
GPO Box 2668 
Adelaide SA 5001 Australia 
Ph: 131 855 

  

International 
Office of the Chief Electrical Inspector 
Ministry if Commerce, New Zealand 
Energy and Resources Divsion 
PO Box 1473 
6015 Wellington New Zealand 

  

 

 

 

 

 

 

 

 

 

 



WinPATS Testing 
For Test and Print Pack Owners (TnT memory)       

It is important not to confuse WinPATS testing with the TnT memory unit functionality. With a TnT memory unit the equipment 
records are transferred to the appliance tester and then the tests are performed independently from the computer. Then the 

equipment test records are transferred back to the WinPATS software. 

If you own a TnT memory unit you will still be able to perform tests VIA the WinPATS software. It is recommended that you learn 
how to use the memory unit by reading the MX operations section. 

If you wish to use operate the tester VIA WinPATS you will need to do the following: 

 If the TnT tester is running in memory mode (unit starts up to the new barcode / search barcode screen) then you will need to 
remove the keypad connection from the top of the tester and reset the power to the unit. Once the unit is displaying the main 

menu A screen then you can continue testing. It is only the WinPATS testing that requires the keypad to be removed. All 
uploading and downloading can be done from the new barcode screen. For more information on the TnT memory click here. 

                                                                                       

  

The First Test - Visual Inspection 

Once the software has been set up to your specific requirements, you can begin testing portable appliances. WinPATS testing 
works by executing a test command to the appliance tester. The test is determined by the chosen test category. Once the TnT 
has completed the test the results are relayed back to WinPATS software and the test is complete. 

Please read the getting connected page before attempting a test. Make sure the TnT is in the main menu A screen before 
starting a test. If the unit is in a sub-menu the TnT will not respond. 

     

THIS TEST IS TO OCCUR BEFORE ANY OTHER TESTS ARE CARRIED OUT USING ANY OF THE 
RANGE OF TNT APPLIANCE TESTERS 

In regard to the device under test (DUT) please ensure that: 

1. There is no damage or component defects to the accessories, plugs, outlet sockets or connectors  
2. There are no cracks/abrasions  
3. There are no exposed inner cores or conductors (flexible) and that the supply cords are not twisted or distorted  
4. Any fuse/overload protection components (if fitted) are checked  
5. All labels, markings and warning indicators (of the maximum load to be connected to the device) are legible and intact  
6. The insulation is not damaged in anyway i.e. melted, cuts, abrasions.  There are no iron filings in the insulation.  There 

is no insulation tape on the lead  
7. Any flexible cords/leads are anchored (glands and grommets intact)  
8. All covers/guards are in place and secure as intended by the supplier/manufacturer  
9. All safety devices and systems are in good working order i.e. latches and buttons  
10. No dust/dirt obstructs any exhausts or ventilation outlets  
11. All controls are working properly and are secure and aligned  

IMPORTANT: IF RESULT IS A FAIL 

IF A DEVICE UNDER TEST (DUT) FAILS ANY OF THE ABOVE, IT SHOULD BE DEEMED TO HAVE FAILED THE VISUAL 
TEST, AND THEREFORE NO OTHER TESTS NEED BE PERFORMED. IF THIS IS THE CASE THE DUT SHOULD BE 

TAGGED WITH A DANGER TAG AND REMOVED FROM SERVICE. IT IS RECOMMENDED BY THE MANUFACTURER 
AND DISTRIBUTOR OF THIS PRODUCT THAT IF A DUT HAS FAILED A TEST IT SHOULD NOT BE RETURNED TO 

SERVICE. TO DO SO WOULD BE CONSIDERED UNSAFE! 



  

WinPATS Testing 

Click images to enlarge 

Screen 1 

 
Screen 2 

 

Screen 3 

 

Screen 4 

 

• Scan/type barcode into the Barcode to SEARCH box and press Enter (Screen 1)  
• Click the Perform Test button or press F8 on the Equipment Details screen (Screen 2)  
• Perform a visual check before clicking Yes or pressing F12 on Screen 3  
• Testing will begin automatically, the test procedure will run through all tests that have been previously assigned during 

the set up process (this information depends on which test/s have been assigned to this item during the initial 
equipment set up).  

If the barcode you have entered is does no exist in the database, you will be asked if you would like to ‘Add Equipment’. To 
enter new equipment into database Click Yes This will bring up the specific ‘Equipment details’ screen with a new barcode 
number. (Please refer to Equipment).  

The test results screen can also be accessed by: 

• Right clicking on any equipment and selecting perform test. 
• Double clicking on a equipment and choosing perform test in the equipment details box. 

  

Screen  5 

 
Screen 6 

 

After the visual check is done (Screen 3) the program will look for a connected TnT tester.  If a tester is not found, Screen 5 will 
appear.  This could be due to incorrectly configured ports.  See General Options Tab for more information.  If the program 
detects a TnT Tester, testing will automatically commence. 

Should the DUT (DEVICE UNDER TEST) have several test types the Next button is displayed on the screen (Screen 6).  If only 
one test type is allocated to the DUT (DEVICE UNDER TEST) then the Next & Skip keys are not displayed. The Skip key moves 
the test to the next test type in the list of tests set up for that particular DUT (DEVICE UNDER TEST).  Alternatively you can 
press F7 which will perform the same function as clicking next.  Pressing F3 or ticking the F3 box will enable all test to be 
performed sequentially after a 5 second interval. 

If an emergency stop is required, click   or hit the esc key on your keyboard.  This will disable the test in progress. 

Screen 7 

 



For TnT-el &  TnT+ testers only 

Screen 7 is a safety warning indicator.  Should the yes button be pressed, the program will control the TnT+ tester and apply 
power to the DUT (DEVICE UNDER TEST). 

CAUTION This test turns the appliance on and can cause an accident or injury if safety precautions are not taken. 

Screen 8 

 

Screen 8 will appear if the DUT (DEVICE UNDER TEST) has failed one of the test parameters.  The user has the option to 
continue and save or go on to next test function if there are multiple tests.  The results will be stored as a failed test result, or 
retry the test as it may have been a testing error. 

If a zebra label printer is connect to the PC make sure the "print after test" box is ticked. Once the test is complete check the 
results and press the OK button. The print progress bar will quickly show on the screen and the tag will be printed. 

 

 

 

 

 

 

 

 

 

 

 

 

 



WinPATS MX Testing 

Overview  

The test and print pack which contains the TnT memory unit gives the ability to test and tag items without the need of a PC or 
laptop on site.  

The TnT memory unit has the ability to store WinPATS records in the testers flash memory. The records can be searched, 
modified and tested using the keyboard and scanner. Once tested a tag is printed from the label printer with a scanable barcode 
as a reference.  

To fully understand the operations of the TnT memory please read the following sections:  

• The current page (WinPATS MX Testing).  
• Managing the TnT Memory.  
• TnT memory operations in the TnT manual.  
• The TnT memory flow chart.  

   

Testing New Equipment  

When testing equipment on a site for the first time you will need to create new equipment on the tester. To create new 
equipment on the tester:  

• Create a site name or use an existing site on the tester. You must select the correct site or the new records will be 
mixed in with another site.  

• Select the correct user from the users list. If no users exist then a user name will need to be created.  
• Check the auto generate number if you are planning to use the auto generate feature.  
• Fill in the new details in the details menu. When creating equipment the location and description details are kept for the 

next piece of equipment if doing multiples of the same equipment type.  
• Do a visual check on the item and perform the test on the equipment. The test category automatically remembered 

based on the test selected in the test menu. This is downloaded as part of the download information.  
• Once tested determine if the item needs retesting.  
• Place the tag on the lead.  

At any point the data can be downloaded to the PC with WinPATS. If data is downloaded multiple times the updated equipment is ignored.  

Retesting Existing Equipment  

Before retesting any equipment you must upload any existing site data from WinPATS. The items that are due for testing need 
to be uploaded but it is quicker to upload the whole site. If this is not done the TnT will report "no equipment found" when 
scanning a barcode. To retest equipment:  

• Select the correct site from the sites page. If the tester is in another site it will not find the barcode.  
• Select the correct user from the users list.  
• Scan or enter the barcode number found on the old tag.  
• Once scanned the details menu will be shown. At this point the details can be changed about the item. These details will 

be updated when they are transferred to WinPATS.  
• Perform a visual check on the item.  
• If the equipment has a previous test category it will display an auto menu to retest with the same test category. If it's 

incorrect it can be changed.  
• Once tested determine if the item needs retesting.  
• Place the tag on the lead.  

At any point the data can be downloaded to the PC with WinPATS. If data is downloaded multiple times the updated equipment is ignored.  

 



Completion of Testing  

 
All sites that have been tested should be downloaded at this point. It is important to download the results and CHECK that the 
results have been updated. Once the database has been checked we recommend you remove the site from the tester to save 
memory space on the tester. Only do this if you have successfully downloaded the equipment and no more testing is required 
until the next testing period. The equipment is not automatically removed in case of a download error.  

The TnT memory has a limited amount of space for each equipment test results. If the previous test results are not removed 
when the next testing is due there might be insufficient space to store the new test results. This is the reason why WinPATS 
downloads the equipment and test results but does not upload previous test results.  

WinPATS only updates the equipment that has test records assigned to it. If the equipment is downloaded into a blank database 
only the equipment that has been tested will be shown. This does not mean that the records have been deleted. You should 
always download into the correct database. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Managing the TnT Memory 

Introduction 

WinPATS MX has the ability to upload and download records from the TnT Memory unit. 

You must have a TnT that capable of uploading/downloading records to begin with. This is normally defined as a TnT M model. 
If not then this page doesn't apply to you. 

Before attempting to use the download/upload feature, ensure the TnT M is connected to the PC and is switched on.  Please 
make sure the TnT is on the enter barcode screen or the Main menu A screen. If it's not the TnT won't communicate with the 
PC. 
 
Please ensure the communications are setup correctly before attempting to download/upload records.  Refer to the Getting 
Connected section for more information. 

To access the download/upload feature of MX, select Download > TnT Communication from the tool bar (Screen 1) 

Setting the Date and Time 

Please make sure that the date / time is set correctly before beginning testing. If it is not set correctly then tests result will be 
incorrect too. 

Click Images to enlarge 

Screen 1 

 

Screen 2  

 

Screen 3 

 

Screen 4 

 

1. When the TnT Uploading menu is accessed, screen 2 will appear.  This is where the data from the TnT M is managed 
and downloaded, click the Date Time tab in the top left hand corner. 
   

2. Screen 3 will appear, this is where the date and time on the TnT can be set to match the current PC date and time.  This 
will also provide a connectivity test to ensure that the TnT is connected properly.  Click Get TNT Date and Time.  If the 
TnT is connected properly, the current date and time that the TnT holds will be displayed in the box next to the the Get 
TNT Date and Time button.  If the date and time on the TnT is incorrect, click Adjust   
   

3. Screen 4 will appear and will show the current date highlighted with a red circle.  The current time can be viewed in the 
right hand corner of the Windows taskbar.  If all is correct, click Apply and the date and time on the PC will be uploaded 
to the TnT.  When this has finished, click Get TNT Date and Time again to ensure that it been uploaded successfully.  

Downloading Records 

Screen 5 

 

Screen 6 

 

Screen 7 

 

Screen 8 

 

1. Go Download > TnT Communications and screen 5 will appear.  Click the Show Sites/Equipment on TNT button.  This 
will retrieve the sites from the TnT and display them in the window.   
   

2. Once the sites have been retrieved, they can be individually selected by clicking the site, or all sites can be selected at 
once by clicking the Select All button. If a site is no longer needed, it can be deleted by selecting the site and clicking 
the Delete Selected Site(s) from TNT button. 
   



3. When the sites to be downloaded have been selected, click the Download Selected Sites f TNT button.  This will begin 
the download process which can be seen in the status window (Screen 7) 
   

4. When the download process has finished the merge function will begin. This will update the database with the 
downloaded data.  

Uploading Records 

Uploading records transfers the equipment to the TnT appliance tester. All records displayed on the equipment inventory will be 
transferred to the TnT tester. You can change what is sent by applying a filter to the equipment inventory. To learn more about 
filters click here. 

For each piece of equipment in the equipment inventory the following fields are sent: 

Barcode, site, location, description, make, model, serial number, asset number, test frequency and test category. No previous 
test results are sent from WinPATS. If the fields are blank then no data is sent. The minimum fields required are barcode, site, 
location and description (This is a minimum requirement for the WinPATS database).  

Upload Procedure: 

Screen 13 

 

Screen 14 

 

Screen 15 

 

Screen 16 

 

1. Go Download > TnT Communications and click the Upload Equipment to TNT tab (Screen 13) 
   

2. Click the Check space available on TNT button, this will show how many items and sites are currently on the TnT 
(Screen 14)  

3. Choose what type of upload method is required (if applicable), see below.  
4. Click the Prepare data for Upload to TNT button, this will display how many items there are in the database that is 

currently open (Screen 15) 
   

5. Click the Upload to TNT button, this will upload the records in the database to the TnT (Screen 16)  

Warning. Do not use the upload function more than once for the same site or if the site already exists on the TnT tester. This 
will create duplicate records on each barcode number. To correctly synchronize WinPATS database with your TnT tester do the 
following: 

1. Click on the download & site management tab and click show sites / equipment on TnT.  
2. Determine if the site that you want to upload already exist on the TnT tester.  
3. Determine if there are test results on the TnT tester (equipment that has been tested in a previous time). If there are no 

test records then skip the next step.  
4. If the test result data is newer on the tester (equipment that have been tested and the test records have not been 

transferred back to the computer) then you will need to download the site first. This is important because if it's not done 
then test results will be lost in step 6. Follow the download procedure in downloading records.  

5. Click the Show Sites/Equipment on TNT button from download and site management tab.  
6. Tick the site you are working with and click the delete site button. Click yes to confirm.  
7. Upload the site you need.  

  

Upload method 
In recent version of WinPATS there are 3 options for uploading. These are: 

• Include equipment from all sites - This will upload all the equipment from the database. Don't select this if you have more than 
5000 equipment in your database or any pre-existing data on the tester.  

• Include equipment from sites not present on TnT - This feature will only upload the sites that are not on the tester. This will 
Prevent double ups on the TnT.  



• Include equipment from main screen only (default) - It is recommend that this option is used. This will only upload what is 
displayed in the equipment inventory. If you need to apply a filter when uploading then this option needs to be selected. To learn 
more about how filters effect the upload process see filters page.  

  

Users on TnT 

Users can be added or removed from the TnT itself or from WinPATS. Its important to set users names before testing. This 
keeps track of who did the testing for the records. 

Screen 17 

 

Screen 18 

 

1. Go Download > TnT Communications and click the TNT Users tab (Screen 17) 
   

2. Click the Show Users on TnT button, this will bring up a list of the users currently stored on the TnT.  You can add more 
users or delete current users by entering/deleting the names in the boxes (Screen 18) 
   

3. When the necessary changes have been done, click Update TnT Users to update the users on the TnT.  

Dictionaries 

Dictionaries allow the predictive text mode to be used on the TnT.  Dictionaries are most useful when using the mini keypad. If 
the test and print kit contains a full size keyboard then you may want to skip the dictionaries section.  Dictionary is basically a 
text file with words in them.  When a dictionary is uploaded to the TnT, words can be entered using the predictive text mode, Eg: 
Wavecom is the word to be entered so 9,2,8,3,2,6,6 is pressed.  This method provides faster input compared to alpha mode.  
Dictionaries can be created from scratch or from words in the database that is currently open.  To create a dictionary from 
scratch, open a notepad file and enter in words that you want to be in the dictionary.  Only one word can be on each line. 

Screen 19 
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1. Go Download > TnT Communications and click the Dictionaries tab (Screen 19) 
   

2. A different different dictionary for each section (Location, Description, Make, Model and Comments) can be uploaded.  
Click on the section that you wish to upload a dictionary to. 
   

3. There is the option of uploading a dictionary from the database that is currently open, from a text file, or from both.  
Select where you want to upload the dictionary from by clicking the check box next to from database data and From text 
file.  If a dictionary is to be uploaded from a text file, click the button with 3 dots to locate the file.  Once a dictionary 
source has been specified, click the Generate Dictionary button.  This will upload the dictionary to the to the TnT 
(Screen 20)  

Flash Format 

The Format Flash feature allows the records on the TnT M to be deleted.  There are two methods in which this can be done: 
Erase Flash Full and Reset Site Index.  Erase Flash Full will delete all records and dictionaries from the TnT M, whereas Reset 
Site Index will delete records only. 

Screen 21 



 

1. Go Download > TnT Communications and click the Format Flash tab (Screen 21) 
   

2. Click the Erase Flash Full or Reset Site Index button, depending on which type of format you want to do.  A warning box 
will appear stating what will happen, click Yes to format.  

  


